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ABSTRACT 

The Louisiana Department of Transportation (LADOTD) has been collecting geotechnical 

data for many years in a variety of different formats. Accessing this data and combining it 

with new data for the purpose of design, analysis, visualization, and reporting is difficult 

because the data have been generated by disparate systems and stored as hard copies, 

scanned images, various digital formats, or other non-digital formats such as microfilm. 

There is neither a single system or repository nor an integrated, systematic approach for 

collecting, managing, archiving, and retrieving the vast amount of geotechnical data collected 

or generated by LADOTD each year. 

 

With advances in computing capabilities, software tools are available that streamline the 

entire data management process from data collection through reporting, archiving, and map-

based retrieval/reporting.  Dataforensics created a plan to integrate and implement a 

customized geotechnical data management system to fulfill the needs of LADOTD.  This 

Enterprise Global Information System (GIS) -based Geotechnical Data Management System 

is comprised of various off-the-shelf software packages including PLog Enterprise, RAPID 

CPT, gINT, ArcGIS, and ArcGIS Server.  It enables LADOTD to store geotechnical data in a 

consistent database format while improving the reliability and accessibility to key 

stakeholders. 

 

The proposed data management system will have significant implications on LADOTD’s 

ability to respond to what might be termed “extreme events.”  This refers to the engineering 

consequences of natural events such as hurricanes and man-induced events, such as bridge 

and other waterfront structure impacts by ships and barges.  In many cases, organizations 

such as LADOTD are required to be able to return the impacted structure to some level of 

functionality in a very short period or else demolish and rebuild a replacement structure in a 

“fast-track” mode. Having this GIS-based geotechnical data management system improves 

their ability to find, utilize, and share the appropriate geotechnical data to meet these 

challenging project demands. 

 

Finally, as part of this project, historical site investigation data has been loaded into the 

LADOTD GIS system.  This involved significant data cleaning and conversion from its 

native format (LADOTD gINT projects, raw CPT data files, consultant data files, etc.) into 

the database structure developed for LADOTD as part of this project.  This includes 

incorporating scanned documents of boreholes, assuming they are geo-referenced.
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IMPLEMENTATION STATEMENT 

The comprehensive Enterprise GIS-based Geotechnical Data Management system will allow 

LADOTD to collect, manage, and report geotechnical data significantly more efficiently and 

consistently. This data management system incorporates borehole data, cone penetration test 

(CPT) data, lab testing data, and pile load test data.   

 

Additionally, the website developed as part of this project will allow LADOTD to locate 

existing boreholes, CPT data, and pile load test data on a GIS interface while providing the 

ability to utilize this data in a variety ways even if it was not originally reported in that 

format.  Users can generate reports dynamically based on the dataset selected on the map-

based interface.  Additionally, having the data stored in a database allows users to create new 

reports in the future to utilize this data in different formats as project requirements evolve 

over time. 

 

Users can combine information with other relevant information such as soil survey maps, 

geologic maps, quadrangle maps, etc. so that appropriate engineering decisions can be made 

with minimal time spent searching for data in the various locations it resides today.   

 

This data management system helps meet the needs of the Geotechnical Design section by 

allowing them to automate various reports they manually compile today.  Additionally, it 

builds on the work completed in project 03-1GT by aiding personnel in the Geotechnical 

Design section to select proper boring depths, pile depths, etc. by providing easy access to 

historical data near their project sites.  Additionally, the comprehensive data that is stored in 

the database, including borehole, CPT, vane shear, and laboratory testing data combined with 

pile load test data, have the potential to improve the pile resistance prediction, and may 

ultimately reduce the cost of foundation construction. 
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INTRODUCTION 

The traditional process for managing geotechnical data that LADOTD currently utilizes is 

similar to the approach utilized throughout a large portion of the geotechnical industry. An 

example of the inefficient, disconnected, and discontinuous nature of this traditional process 

is shown in Figure 1, where in each task for the project, a subset of the data already input 

elsewhere in the process is repeatedly input in separate and disconnected systems. In order to 

ensure adequate data quality, quality assurance/quality control (QA/QC) should be performed 

for each of the data entry processes performed; otherwise, errors associated with repeated 

transcription, as well as typographical, spelling, or even calculation errors may also be 

introduced in the process. 

 
 

Figure 1 

  Typical traditional data management process 

 
All of these undesirable inefficiencies and error sources can be overcome by a 

comprehensive enterprise geotechnical data management system. Within software, a process 

can be implemented that mimics and facilitates LADOTD business process. This enables 

significant streamlining of the data management process used on future projects and ensures 

the long term availability and usability of this data via an Enterprise GIS-based web portal. 

 
With advances in computing capabilities, software tools are available that streamline the 
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entire data management process from data collection through reporting, archiving, and map-

based retrieval/reporting. Dataforensics created a plan to integrate and customize a 

geotechnical data management system to fulfill the needs of LADOTD.  This Enterprise GIS-

based Geotechnical Data Management System is comprised of various off-the-shelf software 

packages including PLog Enterprise, RAPID CPT, gINT, ArcGIS, and ArcGIS Server 

integrated with critical process and workflow components designed and developed as part of 

this project. 

 

      
 

Figure 2 
  Enterprise GIS-based geotechnical data management system 

 

Figure 2 depicts the data flow within the proposed Enterprise GIS-based Data Management 

system. Contrasting the data flow for this system with the traditional data management 

approach shown in Figure 1 highlights numerous achievable efficiencies. Specifically, 
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significant efficiencies result from single source data entry in the field and lab testing data 

entry in gINT.  Furthermore, QA/QC must only be performed once for each data entry point, 

much of which can be automated via validation rules programmed into the data management 

system.  Finally, having a single integrated system then allows the reports to be generated for 

all of the various needs without any data duplication.  Even if the data is not input in the field 

digitally, the streamlining is quite significant from that point forward in the system.  All of 

the data can be archived into the PLog Enterprise GIS system, such that it can be re-used and 

combined with data from future exploration projects.   
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OBJECTIVE 

A typical engineering project is comprised of a number of phases including a review of 

historical information, a field investigation, a laboratory testing program, office-based 

analysis and design studies, full-scale test programs of selected components, construction 

supervision, and post-construction performance monitoring.  With the exception of the 

analysis and design studies phase, all other phases typically result in the generation of 

information and associated reports, which are used in an integrated fashion to complete the 

project. Too often, however, these phases are regarded as relatively discrete activities, and 

this leads to the type of inefficiencies and error sources previously noted. The scope of this 

project is to allow LADOTD to move to the forefront of research and practice by creating an 

enterprise GIS-based geotechnical data management system that allows for the integration of 

historically acquired (likely in non-digital format), recently acquired (likely in digital 

format), and future acquired data (in digital format) so that not only does the composite 

database generated for a particular project benefit that project, but it becomes part of a larger 

knowledge base available for use on other projects being undertaken by LADOTD in the 

future. In order to realize this goal, Dataforensics identified a scope of work that incorporated 

tasks and strategies that require expertise in geotechnical engineering, database systems, GIS 

technologies, process flow, as well as software development and integration. 
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SCOPE 

The scope of the project focused on the creation of comprehensive database structure and reports 

that facilitate the data management process for geotechnical data including borehole data, CPT 

data, vane shear data, test pile load test data, and laboratory testing data.   

 

The type of data included in this database structure is limited to: 

 

 Borehole data and laboratory data that is often generated as a result of samples obtained 

from the borehole.  

 Data types for which LADOTD has access to in a nonproprietary, digital format (i.e., 

CPT data or Test Pile Load Test Data) such that it can be easily imported. 

  Data from proprietary data formats such as Geocomp lab testing files and binary data 

associated with test pile information CAPWAP, WEEP, etc. are not imported into the 

database as they require the proprietary software to read these files. 

 

Within lab testing, basic laboratory testing of soils including natural moisture/natural density, 

Atterberg Limits, sieve, hydrometer, specific gravity, Proctor, unconfined compression, and 

chemical testing are all available in a data format.  More advanced strength testing such as 

consolidation, direct shear, and triaxial have key test results stored in the database but utilize the 

laboratory testing equipment software for the processing of the data in their proprietary format.  

The proprietary raw data files for these tests are stored in the database for future usage, as well. 

 

Additionally, data cleansing and data migration tools were developed to clean existing 

geotechnical data so it can be archived within the PLog Enterprise system.  The scope was 

limited to data compiled in the 03-1GT project including scanned documents for historical 

boreholes, existing LADOTD gINT projects, gINT projects obtained from consultants, and the 

LADOTD CPT raw data format. Other older boring logs, pile driving records, load test reports, 

and other geotechnical data were not archived and would need to be included as a separate 

project. 

 

A custom web-based workflow management/tracking system was developed to facilitate tracking 

the status of projects by LADOTD personnel. 

 

Lastly, a customized GIS-based website was created to allow LADOTD personnel to easily 

visualize and report the data in the geotechnical data management system. 
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METHODOLOGY 

The methodology utilized on this project can be divided into four main tasks with a deliverable 

associated with each task: 

 

 gINT Database and Report Development 

 Workflow Tracking System 

 PLog Enterprise Web Portal 

 Historical Data Cleansing and Archiving 

 

gINT Database and Report Development 

The initial task of the project involved researching the current data management processes and 

software utilized for processing and storing borehole logs and other geotechnical data within 

LADOTD.  The investigation included interviewing LADOTD personnel using questionnaires 

and teleconferences, as well as meetings with the PRC committee members; Headquarters 

Geotechnical Design Group; the Material Laboratory; Information Technology (GIS, Content 

Manager, etc.); and others.  During this process, the types of data to be stored within the system 

as well as representative examples of the various reporting formats were obtained. 

 

Since streamlining the geotechnical data management process was the primary focus of this 

study, the next task focused on developing a comprehensive database structure in gINT and 

PLog Enterprise that encompassed borehole, CPT, vane shear, test pile load test data, and 

laboratory testing data. Once the database structure was designed, validation rules were added to 

ensure the quality and reliability of the data was acceptable. A comprehensive description of the 

validation rules for each table in the database is included in the interim report for the project. 

Examples of validation rules include: 

 

 Verifying that specific data is input for a particular test or record 

 Verifying coordinates are reasonable (i.e., longitude must be negative in Louisiana) 

 Verifying a user has the necessary permission to add, edit, or delete a record 

 Automating various calculations (N-values, CPT correlations, etc.) 

 Verifying samples, layers, and other data types are less than or equal to the depth of the 

hole 

 

Once the database structure and validation rules were finalized, importers for the LADOTD CPT 

format and Test Pile Load Test Data were developed to facilitate automatically, loading data 
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types from their native format into the geotechnical data management systems.  Additionally, 

custom correlations for the Zhang & Tumay Fuzzy and Probabilistic Soil Classification system 

were incorporated into the RAPID CPT software based on research by M. Abu-Farsakh for 

LTRC/LADOTD [2].   

 

Once data could readily be compiled within gINT, reports were developed based on the 

requirements determined in the initial task to mimic existing processes whether already in gINT, 

other software, or manually generated. 

 

Lastly, permission for various groups of users (roles) were assigned in gINT to ensure the 

reliability of the data and eliminate the potential for data being edited or deleted after it has been 

reviewed and approved by the appropriate personnel. 

 

Workflow Tracking System 

The original intent of this task involved designing and developing a workflow tracking system 

similar to the one utilized by the Kentucky Transportation Cabinet (KYTC).  However, as 

researchers initiated the design process, it became clear that the tracking system utilized by 

KYTC was significantly different both in scope and functionality compared with what LADOTD 

requested. 

 

Accordingly, Dataforensics created a draft design document that was presented to the PRC as 

part of the interim report including flow charts depicting the business process today and with the 

proposed system as well as wireframes of the various user interface forms. Feedback was 

provided at that time and the design was refined further. At that time, specific design details were 

guided by a member of the PRC, Ben Fernandez, who would be ultimately managing the system. 

Additionally, the data structure of the ERP system influenced design considerations. 

 

Six weeks after Dataforensics informed LADOTD that the workflow tracking system was 

available to be reviewed as a beta version with significant functionality above and beyond the 

KYTC system was added, Dataforensics was informed that a SharePoint site would be a 

preferred alternative to the workflow system.  However, utilizing SharePoint technology had not 

been indicated to Dataforensics in any of the design phases of the system and would require a 

substantial amount of effort to modify.  Since Dataforensics had already exhausted the budget for 

the development of the site in its current format, Dataforensics ceased development on the 

workflow tracking system.  Dataforensics believes the system is approximately 90-95% complete 

and will serve as an excellent design for adapting it to work within SharePoint.  
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PLog Enterprise Web-Portal 

The PLog Enterprise system already contains a PC-based toolbar that runs in ArcGIS (9.2, 9.3 

and 10.0) that allows users to visualize their geotechnical data within a simple, map-based user 

interface.  From the map, any report configured in the gINT Database and Report Design task 

can be generated based on the live data in the PLog Enterprise database.  Accordingly, this 

functionality was duplicated within a web-based environment to facilitate broader access and 

utilization of the geotechnical data across various LADOTD sections.  Essentially, the goal is to 

make the data in the system accessible via the preconfigured reports developed to facilitate the 

LADOTD workflow process, but not requiring users to have ArcGIS installed. 

 

Accordingly, a flex-based user interface was developed and combined with a newly developed 

ASP.NET middleware application that integrates with existing PLog Enterprise functionality.  

The ASP.NET middleware application and PLog Enterprise are based on .NET framework 4.0. 

The middleware application utilizes pooling technology to allow multiple simultaneous users to 

generate gINT reports served in a PDF format directly to the Flex based user interface.  A 

schematic of the system architecture is shown in Figure 3. 

 

 
 

Figure 3 
  Enterprise GIS-based geotechnical data management system 
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Historical Data Cleansing/Archiving 

A significant amount of effort was required to compile, cleanse, standardize, and archive existing 

historical data utilized in the 03-1GT project.  Data cleansing was the most time consuming of 

these processes but was key to the future usage of the data. The predominant hurdles that had to 

be overcome with the various data formats were: 

 

 Raw CPT data files with latitude and longitude in various formats 

 Existing borehole data in gINT with latitude and longitude in various formats 

 Overloading data fields  

 Existing borehole data without coordinates 

 Existing CPT data and scanned boreholes without coordinates or with coordinates in 

another file format 

 Categorizing each type of hole 

 Incorporating scanned borehole logs into PLog Enterprise 

 Nonsensical coordinates 

 Conflicts between coordinates determined in project 03-1GT and the current project 

 Projects with varying unit systems 

 Duplicate Project IDs 

 Duplicate data 

 Text data that should be numeric 
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DISCUSSION OF RESULTS 
 
The results of this project can be found in the gINT files provided to LADOTD and will be 

located on the LADOTD Intranet.  A discussion of the results follows. 

 

Raw CPT Data Files Latitude and Longitude 

The CPT data files from the 03-1GT project were attempted to be imported into gINT using the 

LADOTD CPT importer developed as part of this project. It quickly became apparent that the 

majority of the CPT files could not be imported properly because the latitude and longitude were 

in a variety of different formats.  Accordingly, a VB.NET tool was created to attempt to convert 

and log the various formats for the latitude and longitude.  In this process, six regular expressions 

were developed for deciphering the latitude and longitude that comprised approximately 18 

various formats.  The latitude and longitude were predominantly in either a degrees-minutes-

seconds format or a decimal-degrees format.  However, it is easy to imagine the combinations 

that can occur:  spaces may not exist between each component (degrees, minutes, seconds), the 

minutes (‘) or seconds (“) symbol may not exist at the end of each component, the “N” or “W” 

indication in the string may not exist, and/or a “-” may not exist in front of the longitude. 

 

Existing Borehole Data in gINT Latitude and Longitude 

The gINT data files compiled as part of this project were significantly more consistent than the 

raw CPT data files. Only two regular expressions were developed to parse the latitude and 

longitude into a consistent format, one for decimal degrees and one for degrees, minutes, and 

seconds.  

 

Overloading Data Fields 

The existing gINT data files compiled as part of this project contained multiple data types within 

the same field [ex. standard penetration test (SPT)_or_ undrained unconsolidated (UU) field in 

the sample table].  This is a violation of the normal forms of database design because it makes it 

much more difficult to work with the data. One type of data was the format was the undrained 

strength and confining pressure for the UU test.  It was indicated as 5.933@16.5 where 5.933 is 

the strength in tons per square foot (tsf) and 16.5 is the confining stress in pounds per square inch 

(psi).  In the same field, there were also blow counts and N-values stored.  To determine if it was 

an N-value, it is stored as N=value.  To determine if it was three separate blow counts, it was 

indicated as 1-2-3, where each number is the blow count for a particular interval.   
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To clean this data, Gavin Gautreau enlisted a student worker to replace all N-values with the 

individual blow counts in the same format (i.e., 1-2-3).  Then, the data was migrated from the old 

database structure to the new database structure developed as part of this project. During this 

process, UU data was transferred into its own table with fields for “Confining Pressure” and 

“Undrained Strength,” while the blow counts were separated into three different fields with a 

fourth field that automatically calculates the N-value. 

 

Existing Borehole Data without Coordinates 

The existing borehole gINT data files in some instances lacked coordinates in the gINT file.  If 

boreholes were missing coordinates, Dataforensics requested the coordinates of the holes from 

LADOTD personnel and added them to the gINT files as latitude/longitude in decimal degrees 

format. All existing borehole data had coordinates and thus were categorized as “Legacy 

Boreholes” to allow for differentiation of this Hole Type on the GIS map. 

 

Existing CPT Data without Coordinates 

The existing CPT data files in some instances lacked coordinates in the raw data file. In these 

scenarios, the GIS layers developed as part of 03-1GT were utilized if the coordinates were 

present there. These CPT soundings were classified as a Hole Type of “CPT.” Alternatively, if 

no coordinates were identified in the GIS coverage, the Excel spreadsheets compiled as part of 

the 06-6GT project were utilized for identifying the location of the soundings.  If no location was 

known from the spreadsheets, the average location of all known CPT soundings was determined 

for a project and each sounding with an unknown location was assigned this latitude and 

longitude.  In these scenarios, Hole Type was indicated as “CPT – Est. Location” so that users of 

the GIS application would see different symbology for these holes and understand that the 

location is approximate. 

 

Scanned Boreholes without Coordinates 

The scanned borehole data in some instances lacked coordinates in the scanned document. In 

these scenarios, the GIS layers developed as part of 03-1GT were utilized if the coordinates were 

present there. These boreholes were given a Hole Type of “Scanned Borehole”.  Alternatively, if 

no coordinates were identified in the GIS coverage, the Excel spreadsheets compiled as part of 

the 06-6GT project were utilized for identifying the location of the borehole. If no location was 

known from the spreadsheets, the average location of all known boreholes was determined for a 
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project and each sounding with an unknown location was assigned this latitude and longitude.  In 

these scenarios, Hole Type was indicated as “Scanned Borehole – Est. Location” so GIS users 

would see different symbology for these holes and understand that the location is approximate. 

 

Categorizing Each Type of Hole 

As indicated in the previous two sections, different hole types were identified depending on the 

source of the data and the reliability of the location.  Other categories were included in the gINT 

configuration, such as Borehole and Test Pile.  Borehole will be utilized by LADOTD as new 

data is input in the gINT format.  Test Pile will be utilized by LADOTD as new test pile load test 

data is imported into the system. Dataforensics recommends making the “Hole Type” field 

required in order to ensure differentiation of the points on the GIS map in the future. 

 

Incorporating Scanned Borehole Images 

In order to make the scanned borehole logs accessible in the PLog Enterprise system, the 

scanned boreholes must be added into a gINT project. The process requires adding a new record 

for each borehole in the Point table and inputting critical metadata such as PointID, HoleDepth, 

Latitude, Longitude, Hole Type (Scanned Borehole or Scanned Borehole – Est. Location) and 

inputting the file path for the scanned image in the associated file in the Point table. 

 

Nonsensical Coordinates 

For some projects, the latitude and longitude provided in the scanned boreholes were incorrect 

coordinates (meaning they were incorrectly printed on the scanned log report). Dataforensics 

identified these coordinates as nonsensical because they contained either minutes or seconds that 

were greater than 60. In these scenarios, LADOTD employees were utilized to identify the 

correct coordinates, which were then loaded into the system. 

 

Conflicts between Coordinates Determined in 03-1GT Project and Current Project 

For some projects, the latitude and longitude indicated in the ArcGIS layer differed from what 

Dataforensics identified as coordinates from the CPT data files or other sources. In these 

scenarios, Dataforensics deferred to coordinates from the 03-1GT project. 
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Projects with Varying Units 

For some of the projects with scanned boreholes, the scanned images were in metric units; thus, 

the station, hole depth, and elevation values input into the system were converted to English 

units to be consistent with all the other data.  There were no projects in gINT that were provided 

in metric, so the correspondence file written to convert historical data from the previous 

LADOTD gINT database format to the database format created as part of this project only 

supports English units. 

 

Duplicate Project IDs 

Several projects could not be imported into the database, because there were already projects 

with the same identifier and boreholes with the same identifier in the database.  The duplicate 

project IDs were limited to three projects where the Design Number was indicated as “General 

Engineering.”  For each of these projects, the Design Number value was changed to the name of 

the project, e.g., LA 488 Slope Failure, LA 8 Slope Failure, and US 84 Slide.   

 

Duplicate Hole IDs 

Several projects that contained duplicate Hole ID’s for a Project ID had already been loaded into 

the PLog Enterprise system.  The source of this problem seemed to be in the compilation of data 

from one of the previous projects; the previous researchers allowed a CPT sounding to be 

referenced in multiple folders/Excel files.  As Dataforensics developed gINT projects, a new 

project was created based on the name of the folder and then the raw CPT data from the text file 

was imported.  This resulted in the same CPT file being loaded into multiple gINT projects 

because the same raw data files were present in multiple folders. Table 1 below indicates the 

folders where duplicate data for specific Project ID and Hole ID combinations resulted. 
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Table 1 

  Duplicate CPT data file locations 
 

Project ID Hole ID Original Folder Name Duplicate Folder Name(s)

455-05-62 BT3 DIST 08\RAPIDES\455-05-62\DEE0562
DIST 08\RAPIDES\455-05-62\DEE0562\RAMPD2 DIST 08\RAPIDES\455-
05-62\DEE0562\RAMPD9 DIST 08\RAPIDES\455-05-
62\DEE0562\RAMPD9T

700-23-0200 CPT1 DIST 03\IBERIA\700-23-0200 DIST 03\IBERIA\700-23-0200\LOREAUVILLE

700-23-0200 CPT2 DIST 03\IBERIA\700-23-0200 DIST 03\IBERIA\700-23-0200\LOREAUVILLE

005-07-0057 1 DIST 02\LAFOURCHE\700-29-0120\005-07-005DIST 02\ST. CHARLES\005-07-0057

005-07-0057 CPT1 DIST 02\LAFOURCHE\700-29-0120\005-07-005DIST 02\ST. CHARLES\005-07-0057

005-07-0057 CPT2 DIST 02\LAFOURCHE\700-29-0120\005-07-005DIST 02\ST. CHARLES\005-07-0057

362-01-0009 B1 DIST 08\NATCHITOCHES\362-01-0009 DIST 08\NATCHITOCHES\362-01-0009\BAYOU NID AIGLE

362-01-0009 B2 DIST 08\NATCHITOCHES\362-01-0009 DIST 08\NATCHITOCHES\362-01-0009\RAT BOIS BAYOU  
 
 

Project 424-07-21 provided a different set of challenges that expanded on the challenges 

identified in the previous paragraph.  There were 26 CPT soundings in the project, half of which 

were missing coordinates and the other half already archived in PLog Enterprise.  This is a result 

of the problem identified above, compounded by the fact that the raw data files for the CPT 

soundings were renamed either in one of the previous projects that compiled the data or when the 

data was generated. Refer to Table 2, which indicates the duplication of the data.  Note that all 

values are identical, except the Hole ID with the one exception of the total depth for Hole IDs 

105+53/CP1.  It is Dataforensics assertion that it is very difficult if not impossible to push 

duplicate soundings at exactly the same start date/time (to a precision of seconds) and to the 

same total depth to a precision of 0.01 ft. Therefore, the soundings on the right half of the table 

were removed. 
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Table 2 

  Duplicate CPTs from project 424-07-21 

Hole ID Total Depth Start Date Hole ID Total Depth Start Date

105+53 144.03 11/8/1995 8:13 CP1 144.01 11/8/1995 8:13
113+89 155.31 11/8/1995 10:29 CP2 155.31 11/8/1995 10:29
120+66 154.81 11/7/1995 10:15 CP3 154.81 11/7/1995 10:15
121+42 124.91 11/7/1995 11:21 CP4 124.91 11/7/1995 11:21
122+18 125.31 11/7/1995 0:20 CP5 125.31 11/7/1995 0:20
122+95 127.31 11/7/1995 13:24 CP6 127.31 11/7/1995 13:24
123+71 144.61 11/7/1995 14:30 CP7 144.61 11/7/1995 14:30
124+47 113.51 11/7/1995 15:41 CP8 113.51 11/7/1995 15:41
125+23 135.31 11/7/1995 9:12 CP9 135.31 11/7/1995 9:12
125+98 117.71 11/7/1995 8:05 CP10 117.71 11/7/1995 8:05
126+75 123.81 11/6/1995 16:33 CP11 123.81 11/6/1995 16:33
127+51 118.11 11/6/1995 15:28 CP12 118.11 11/6/1995 15:28
113+90 95.01 11/7/1995 16:46 TESTC2 95.01 11/7/1995 16:46  

 

Text Data that Should be Numeric 

In the process of converting data from the old structure to the new structure, there were several 

instances where various values for elevation or hours after drilling were indicated as the 

combination of a number and some string describing it (i.e., approximately 0 or 18 hrs).  These 

were manually cleaned as the problems were discovered. 

 

Once all the data was cleaned and converted to a consistent format, it was then loaded into the 

PLog Enterprise system.  A total of 1645 distinct locations were archived in the system. This can 

be subdivided into the specific Hole Types categorized herein, as shown in Table 3.  Note that 

for the Scanned Boreholes and Scanned Boreholes with Estimated Locations, the exact number 

of locations is known for those that appear on the map, but in some cases the scanned images 

contained multiple boreholes, which were not all geo-referenced, therefore more borings may 

exist than the counted number on the map.  
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Table 3 
  Hole types archived in PLog enterprise 

 

Hole Type Number of Holes

Scanned Boreholes 153*
Scanned Boreholes with Estimated Location 35*

Legacy gINT Boreholes 297
CPT Soundings 1080

CPT Soundings with Estimate Location 11
Boreholes in new gINT Format 69  

 

Process for Archiving Historical Data 

During this project, a significant amount of data was archived into the PLog Enterprise system.  

The process for loading historical data depends on the format of the data.  The formats of data 

that were archived are: 

 CPT data files 

 LADOTD gINT projects 

 Ardaman gINT Projects 

 Scanned PDF logs 

 

A description of the process to load the aforementioned files into gINT is described below, 

followed by a description of archiving the data in PLog Enterprise.  

 

CPT Data Files 

CPT Data files can be imported into gINT using RAPID CPT directly.  

 Choose the appropriate importer from the Add-ins menu. 

 Select the correspondence file (ladot rapid cpt.gci). 

 Select the file(s) to import.  

 

Once the data is in gINT, ensure the coordinate system is defined in the Project tab as well as the 

Hole Type and coordinates in the Point table.  Add any other metadata about the Project/Points 

and then proceed to archiving it in PLog Enterprise.  
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LADOTD gINT Projects 

Dataforensics has written a correspondence file that converts the previous LADOTD gINT 

project database structure to the new database structure that is more comprehensive. The process 

to convert the data is: 

 Create a gINT project based on the new LADOTD gINT files. 

 From the file menu->Import/Export->Import from database. 

 Choose the legacy gINT project as the source database. 

 Choose the correspondence file (ladot legacy to ladot 2012.gci). 

 Click ok. 

 

Once the data is in gINT, ensure the coordinate system is defined in the Project tab as well as the 

Hole Type and coordinates in the Point table.  Add any other metadata about the Project/Points 

and then proceed to archiving it in PLog Enterprise.  

 

Ardaman gINT Projects 

Dataforensics has written a correspondence file that converts the Ardaman gINT project database 

structure to the new LADOTD database structure. The process to convert the data is: 

 Create a gINT project based on the new LADOTD gINT files. 

 From the file menu->Import/Export->Import from database, 

 Choose the Ardaman gINT project as the source database. 

 Choose the correspondence file (ardaman to ladot 2012.gci). 

 Click ok. 

 

Once the data is in gINT, ensure the coordinate system is defined in the Project tab as well as the 

Hole Type and coordinates in the Point table.  Add any other metadata about the Project/Points 

and then proceed to archiving it in PLog Enterprise.  

 

Scanned PDF Logs 

The new LADOTD gINT database structure incorporates the capability to include a document 

associated with each Point (Borehole).  The process to load this data into gINT is as follows: 

 Create a gINT project based on the new LADOTD gINT files. 

 Input the Project Information. 

 Input a record in the Borehole table for each separate point location (borehole, CPT, vane 

shear, etc.).  Specify the coordinates for each point and in the Associated File field, 

specify the filename of the PDF that contains the scanned document. 
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The coordinate system must be defined in the Project tab, as well as the Hole Type and 

coordinates in the Point table.  Add any other metadata about the point as necessary and then 

proceed to archiving it in PLog Enterprise. 

 

Archiving Data in PLog Enterprise 

Once the data has been loaded into gINT in the LADOTD format, it can then be archived into 

PLog Enterprise, which automatically makes the data available to anyone utilizing the PLog 

Enterprise system whether via the web application or ArcGIS. To archive the data in PLog 

Enterprise, refer to section IV in the PLog Enterprise User’s Manual. 
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CONCLUSIONS 
 
This project developed a comprehensive geotechnical data management system that will allow 

LADOTD to streamline their data management process for borehole, lab testing, CPT, in-situ 

vane, and test pile load test data while providing long-term availability of the data via a web-

based GIS portal.  By standardizing the database structure, and incorporating validation rules and 

custom reports LADOTD personnel in various sections can more easily access and report their 

geotechnical data while simultaneously improving the quality and reliability of the data.  

 

Dataforensics provided a single system for managing all active project data and enabling it to be 

easily archived into the PLog Enterprise GIS based data management system accessible via a 

customized web-based GIS, which will allow the Geotechnical Design section access boring logs 

and other geotechnical documents via the Intranet.  The GIS interface can access many different 

sources and types of data both within and outside the Department.  The quick and easy access to 

valuable data, including the mapping applications in the GIS, will streamline and facilitate the 

analysis of data.  

 

This project builds upon the work completed in project 03-1GT to create a reference resource 

that will continue to grow over time that will aid in the evaluation of specific geotechnical site 

data, which will allow for more accurate and cost effective design decisions.  Additionally, this 

project archived data compiled in the 03-1GT project and the 06-6GT project as the first data 

loaded into the system.  If LADOTD were to try and re-create this same data by re-investigating 

the same sites, the cost would be at least $16,000,000 ($10000 per borehole/CPT sounding).  

Accordingly, the return on investment for this task is extraordinary as approximately $20,000 

was expended to turn $16,000,000 worth of data into a usable asset. 

 

Various meetings and demonstrations of the system have been given to various members of the 

PRC.  The technology utilized in the system described herein uses off-the-shelf software 

products PLog Enterprise, RAPID CPT, gINT, ArcServer, Flex and ASP.Net technology.  The 

website is located on the Intranet and is ready to serve the Geotechnical Design section and 

others in the Department.   
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RECOMMENDATIONS 
 

Website and Server Maintenance 

Website and Server Maintenance:  Perpetual licenses were included with research, meaning 

LADOTD can use the software indefinitely.  Maintenance and periodic updates should be 

applied to the software in order to ensure proper function with an optimal performance.  This 

will require combined efforts and ongoing support of both the GIS Team at LADOTD and 

Dataforensics.  One year of support for RAPID CPT and PLog Enterprise is included in the 

current contract.   

 

Personnel and Access 

It is recommended that a Geotechnical Design section employee be designated to manage the 

PLog Enterprise system (i.e., upload the gINT projects whether developed by consultants or in-

house) so that records are kept timely and accurate in digital format. 

 

The website will be located on the LADOTD Intranet.  A goal for a follow-up project should be 

to open the website to the public.  Additional efforts regarding firewalls will need to be 

implemented for this to occur. 

 

Site/Materials Manager 

The incorporation of data from the Site/Materials Manager is unknown at this time.  

Dataforensics believes that incorporating borehole and lab test data from shallow boreholes into 

the PLog Enterprise system should be accomplished in order to maximize the value of the 

LADOTD database. The data types for the basic laboratory testing have been implemented 

already within the database structure, but reporting capabilities in gINT likely need to be 

enhanced and tailored to LADOTD’s specific requirements.  This was outside the scope of this 

project since it was focused on deep boreholes. 

 

Loading Additional Historical Data 

LADOTD now has a platform on which a tremendous amount of historical data can be loaded 

into the system quite easily. The difficulty involved with loading historical data is 

obtaining/finding the historical data and/or converting it into the standard format.  For historical 

data that consists of scanned images, there is no conversion necessary.  For this type of historical 

data, it simply requires creating a gINT project and filling in the appropriate project and borehole 
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metadata to identify the project/hole and associating the scanned image with the point(s).  A 

student worker could perform this task with minimal guidance from Dataforensics.  

 

Dataforensics recommends a follow-up project where the budget can be explicitly allocated to 

pay a consultant to compile the gINT projects and provide to Dataforensics for the work they 

have performed for the LADOTD in the last few years.  This would then provide datasets that 

can be cleansed and converted into the new LADOTD format. 

 

Workflow Application 

Dataforensics recommends a follow-on project to complete the workflow application using 

SharePoint functionality since it is an internally supported platform that is now available and 

suitable to manage the workflow related data and documents. 

 

Future Modules 

All current and future data should be recorded and stored digitally within PLog Enterprise so that 

as the data grows, it can be accessed easily via the map-based GIS interface.  Enhancements to 

the system such as incorporating additional data types (i.e. extracting binary data from 

CAPWAP, WEEP, or the GeoComp systems) could prove to be useful from a data mining 

perspective over the long term.    

 

Additionally, LADOTD may consider adding spatial and non-spatial data mining algorithms into 

the system to automatically search for and identify trends in the data that are not obvious until 

they are specifically examined. Data mining allows users to gain a better understanding of their 

data by discovering new patterns in their large datasets. PLog Enterprise provides the foundation 

for this to occur. 
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ACRONYMS, ABBREVIATIONS, AND SYMBOLS 

CPT   Cone Penetration Test 

GIS   Geographic Information System 

KYTC   Kentucky Transportation Cabinet 

LADOTD   Louisiana Department of Transportation and Development 

LTRC   Louisiana Transportation Research Center 

QA/QC  Quality Assurance/Quality Control 

SPT   Standard Penetration Test 

UU   Unconsolidated Undrained Triaxial Test 
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 I. PLog Enterprise Overview  

 
The PLog Enterprise Edition has all the capabilities of the standard edition plus many other 
features that allow you to get more out of your data.  The PLog Enterprise Edition uses an 
enterprise database (Microsoft SQL Server or Oracle) instead of a Microsoft Access Database 
as with the PLog standard edition.  The SQL Server/Oracle database allows more users to 
simultaneously use the system, has more data storage capacity, and is scalable (i.e. the 
database can grow nearly without limit over time by adding new hardware).    
 
Additionally, the PLog Enterprise Edition allows you to archive data from gINT projects into a 
single database.  Instead of having tens or hundreds or thousands of individual gINT projects, 
all data can be archived into a single database for querying, data mining, and reporting.  The 
PLog Enterprise Edition requires a consistent database structure in order to archive the data.   
 
For a project, once all soil borings, dilatometer test soundings, cone penetration test soundings, 
test pits, wells, inclinometers, and lab testing have been finalized in gINT, simply archive the 
data using the PLog Enterprise PC module.  All boreholes must have coordinates in order to 
archive the data, in order to allow the points to be plotted with the GIS application, a key 
element to the enterprise system.  During this process the PLog Enterprise will convert the 
coordinates (if necessary) from a regional coordinate system such as State Plane, UTM, etc to a 
global coordinate system, such that all boreholes can be mapped in a single, consistent 
coordinate system simultaneously. The PLog Enterprise Edition uses WGS 84 with Latitude and 
Longitude for mapping purposes; however the coordinates you have input for your boreholes 
are not modified in any way. 
 
Not only can you archive the data, the PLog Enterprise Edition allows you to retrieve data from 
the Enterprise database as well via a GIS (geographic information system) interface.  Using 
ArcGIS 9.2 or 9.3, you can view all boreholes archived in your database and select specific 
boreholes on the map to generate any gINT report.  Simply choose the boreholes you want 
report and select the appropriate reporting tool in the GIS. 
 
There are several other capabilities in the PLog Enterprise Edition that help you mine your data. 
Examples include buffering a project site to determine all boreholes within a specified distance 
of the site; buffering a linear alignment such as a road, dam, or levee to find all boreholes within 
a specified distance of the alignment; and a query tool that allows you to generate very 
complicated queries using a graphical user interface.  Additionally, queries can be written in 
SQL for more advanced and complicated queries.   
 
Queries may be written to facilitate business analyses such as to determine drilling quantities on 
a weekly or monthly basis, by drill rig, or however you may want to view the data.  Other queries 
may be for engineering purposes.  For example, if you are interested in liquefiable soils, you 
may want to query all SPT data in the upper 15 feet where the blow counts are less than 8 and 
the soil type is sand or silty sand. 
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II. PLog Enterprise Roles 
 
Prior to archiving any data, your database administrator (DBA) must add logins for each user in 
SQL Server Enterprise Manager in SQL Server 2000 or the SQL Server Management Studio in 
SQL Server 2005 or in Oracle’s Management Studio.  Database administration is not covered 
within this manual other than basic guidance that relates to the operation of PLog Enterprise.   
 
Logins are added under the security tab in the SQL Server Enterprise Manager.  For each login, 
they should be granted access to the PLog and Site Investigation Archive databases.  
Additionally, logins must be defined as a specific role: Dataforensics Admin, Dataforensics 
Power User or Dataforensics Standard User.  The role determines the capabilities available to a 
user within PLog Enterprise. 
 
Features available to each role: 
 

 A Dataforensics Standard User can only retrieve data and execute queries. 

 A Dataforensics Power User can archive and retrieve data as well as save and 
execute queries. 

 A Dataforensics Admin User has all the capabilities of the power user and they can 
upsize the database, define the primary key, and perform the configuration. In the long 
term, the Admin users will be allowed to re-archive data and also re-upsize the database 
to add new tables and fields. 

Adding a Login for PLog in SQL Server 

 Within Enterprise Manager select the 
Security tab. 

 Right click the Logins group and select 
New Login. 

 Fill in the username. 

 Select SQL Server Authentication and 
add a password. 

 Select the Database as PLog.  
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 Click the Database Access tab. 

 Check the Permit Checkbox in the 
PLog and Site Investigation databases. 

 Check the appropriate role in the 
Permit in Database Role list. This 
should be a Dataforensics Admin, 
Dataforensics Power User or 
Dataforensics Standard User. 
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III. PLog Enterprise Initialization 
 
After defining the roles, your DBA may need to perform some basic initialization in order for the 
archiving process and PLog GIS Toolbar to operate correctly.  To begin the initialization 
process, start the PLog Enterprise Application from the Start menu on your PC. If you setup the 
connections properly during the installation for the PLog and PLogArchive databases, there 
shouldn’t be a need to modify the connections, but you may want to test each connection. The 
connections information is stored in the Connections.xml file. 

Modifying Connection to Database Server 
For large enterprise deployments, it is recommended that this file be stored in a shared location 
on a server (where the Library.mdb file is located possibly).  If you need to change the 
connection properties, follow the steps below.  
 

SQL Server Connection Properties 
 

 The screenshot shown to the right 
indicates how to setup the connection 
properties for a SQL Server database.   

 The server is the name of the SQL 
Server Database Instance. This is 
shown at the top of the SQL 
Management Studio. 

 The Catalog Name is the name of the 
database. 

 For testing purposes the first time you 
create the connection string, add the 
user id and password prior to clicking 
the test button. Delete this after 
verifying the connection the user ID 
and password after verifying the 
connection. 
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Oracle Connection Properties 
 

 The Oracle connection properties are 
shown to the right.  We recommend 
using the following as your Server.  
This eliminates the need for TNS or 
other configuration on each client 
machine. 

 (DESCRIPTION=(ADDRESS_LIST=(A
DDRESS=(PROTOCOL=TCP)(HOST=
XXX.XXX.XXX.XXX)(PORT=1521)))(C
ONNECT_DATA=(SERVER=DEDICAT
ED)(SID=YYYYYYYY))) 

 XXX.XXX.XXX.XXX (above) is the IP 
address of the server and YYYYYYYY 
(above) is the SID of the database 
server. 
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Data Structure 
The PLog Enterprise system uses the gINT database structure for your organization as the 
basis for the database structure within PLog Enterprise.  You must first load this structure prior 
to using PLog Enterprise. The following directions instruct you how to load the data structure. 
 
Before loading the data structure, you must be sure your database has the required minimum to 
work in PLog Enterprise. Your database must have: 

• A column in the project table that uniquely identifies one project from another 
• A field in the project table used to define the coordinate system 
• If you use projected and unprojected coordinate systems, the database must have fields 

for geographic and projected coordinates for locating your boreholes, (i.e. fields in your 
database for Latitude and Longitude (geographic) as well as North and East (projected)).   

• If you want to plot different hole types using different symbols on the GIS map you must 
have a Hole Type field 

 
 
 

 At this time, you should 
now see 4 nodes in the 
tree – Field Projects, 
Work Orders, Archive 
Projects and Data 
Collector Configuration. 

 Select the Archive 
Projects and you should 
see Connections and 
Data Structure. 

 Select the connections 
node and verify you are 
using the desired 
database connection.  
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 Select the Data Structure 
node. 

 Choose the gINT project 
file to use as the basis of 
the database structure. 

 Select the column in the 
project table that 
uniquely identifies one 
project from another. 

 Click the Create Archive 
button. If any errors 
occur, click View Log on 
the progress dialog.  

 

Map Settings 
In order for PLog Enterprise to map your boreholes in a consistent coordinate system, PLog 
Enterprise must be able to determine the fields used for your coordinates.  PLog Enterprise 
supports using both projected and unprojected (geographic) coordinates.  Projected coordinate 
systems include UTM and State Plane whereas geographic coordinates are Latitude and 
Longitude.  If you use both geographic and projected coordinates for locating your boreholes, 
you should have fields in your database for Latitude and Longitude (geographic) as well as 
North and East (projected).  The Configuration Dialog allows you to define the fields used in 
identifying the coordinate system as well as the fields used for the coordinates. 
 

 Specify the fields in the 
Point table used for 
defining the projected 
and geographic 
coordinates. 

 Specify the field in the 
Project table used to 
define the coordinate 
system. 

 

 

 
Note: There must be a field in the project table used to 
define the coordinate system. 
 
Note: If you want to plot different hole types using 
different symbols on the GIS map you must specify the 
Hole Type field. 
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File Settings 
In order for PLog Enterprise to map your boreholes in a consistent coordinate system, PLog 
Enterprise must be able to determine the fields used for your coordinates.  PLog Enterprise 
supports using both projected and unprojected (geographic) coordinates.  Projected coordinate 
systems include UTM and State Plane whereas geographic coordinates are Latitude and 
Longitude.  If you use both geographic and projected coordinates for locating your boreholes, 
you should have fields in your database for Latitude and Longitude (geographic) as well as 
North and East (project).  The Configuration Dialog allows you to define the fields used in 
identifying the coordinate system as well as the fields used for the coordinates. 
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 Specify the default 
directory where gINT 
projects are stored 
on your network. This 
simplifies accessing 
the files during 
archiving. 

 If you are using SDE 
(Spatial Database 
Engine) in ArcGIS 
select the SDE radio 
button.   

 If you are using a 
personal 
geodatabase in 
ArcGIS, select 
personal 
geodatabase radio 
button and then 
browse to the 
Boreholedatabase.m
db file. 

 

 
Note: The boreholedatabase.mdb file is the personal 
geodatabase used by ArcGIS for mapping the points.  It must 
be located on the server in a shared folder and have been 
installed previously during the PLog Server installation. 

 

 

Coordinate Systems and Aliases 
You should create a library table in your gINT library that defines the coordinate systems as well 
as a coordinate systems field in the gINT project such that whenever a user is creating a project 
in gINT, they select the coordinate system from a standard list of valid coordinate systems that 
can be mapped in the GIS.  
 
In order for PLog Enterprise to recognize the coordinate systems, this list of coordinate systems 
must be mapped to the projection and transformation (if necessary) from ArcGIS. Dataforensics 
provides a mapping of 871 coordinate systems within the PLog Enterprise Edition. This mapping 
is an Excel file called Complete Coordinate Systems.xls. All that must be done is provide an 
alias for the appropriate coordinate systems you are using in the Complete Coordinate 
Systems.xls.   
 
For example, if you are using the Alabama State Plane East Zone in units of feet, you must 
open the Excel spreadsheet and define this as the alias.  In the Excel spreadsheet, you must 
find the NAD 1983 StatePlane Alabama East FIPS 0101 (Feet) in the ArcGIS Projection Name 
column.  Then copy ‘Alabama State Plane East Zone’ (or whatever value you have defined in 
your library table) into the Alias Column.   
 
Repeat this procedure for each coordinate system you need to use. Once you have finished 
creating the aliases you are ready to load the coordinate systems.  Save the Excel file as a tab 
delimited text file. 
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Note: The alias you saved in the Excel file should match the coordinate system name you have 
added to your coordinate system table in gINT. 
 
Below are the directions for loading the Complete Coordinate Systems.xls once you have 
mapped your aliases to appropriate coordinate system names.  
 

 Click the Load 
Coordinate Systems 
button and select the tab 
delimited text file. 

 

 
 

 Once the coordinate 
systems have been 
imported, you should see 
them in the panel as 
indicated here. 

 

 
 

SDE Configuration 
Clicking on the SDE Configuration node allows you to determine if your configuration is 
complete.   
 
If you are using a personal geodatabase, the configuration is complete.   
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If you are using SDE, you need to complete the configuration using the PLog ArcGIS toolbar or 
manually configure the SDE Connection file and Load the Feature Class into the database using 
ArcCatalog. The directions below detail how to complete the configuration using the PLog 
Toolbar. 
 

 Start ArcMap. 

 If the PLog ArcGIS toolbar has not 
loaded, refer to Section IV.  

 On the PLog ArcGIS toolbar, login 
using an Administrator role based 
login. 

 Click the Configuration button in the 
PLog ArcGIS toolbar 

 

 This dialog is the same dialog you get 
when creating a SDE database 
connection in ArcCatalog.  

 Fill in the values for your SDE 
connection. 

 Select Test Connection to verify the 
connection succeeds. 

 
 Once you have defined the connection, 

click the Load Feature Class button 
and specify any SDE CONFIG 
keyword. 

 Browse to the Boreholedatabase.mdb 
file located in the shared folder 
installed previously during the PLog 
Server installation.  Select the file to 
load the feature class. 

 Lastly, select the Add Borehole Trigger 
to ensure deleting and updating gets 
cascaded properly from the Point table 
to the Borehole Feature Class and vice  
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versa. 

 Once you have loaded the feature 
class into the Enterprise database, you 
should see that SDE Configuration is 
complete. 
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IV. Archiving Data 
Once you have completed the PLog Enterprise Initialization, you are ready to begin archiving 
data.  
 

 Click the Archive 
Projects node in the 
PLog Enterprise 
Application. 

 
 Click the Archive button. 

 

 Choose the one or more 
gINT Projects to archive. 
Click Open. 

Warning: For projects with 
large amounts of data, such 
as CPT data, the archiving 
process can take several 
minutes. 
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 If there are any problems 
during the archiving 
process, they will be 
indicated in X in the task 
panel and you can view 
the errors in the Errors 
panel as well as 
reviewing the error log by 
clicking View log.   

 If you have any 
questions about the error 
messages contact 
Dataforensics support. 
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V. PLog GIS Toolbar 
 
The PLog ArcGIS Toolbar must be enabled within ArcGIS in order to utilize its capabilities.  It 
should be enabled by default, if not follow the directions below. 
 

 Start ArcMap from the Start menu. 

 From the Tools menu, select 
Customize 

 In the list of Toolbars, select PLog 
ArcGIS Toolbar. If it is not shown in the 
list of toolbars, click File => Add and 
choose the PLogToolbar.tlb located in 
the c:\program files\PLog\PLog Toolbar 
folder or wherever you installed PLog 
on your PC. 

 Click Close   

 To the right is a screenshot of the PLog 
toolbar prior to logging into the system. 

 

 

 Once you have logged into the system, 
the other tools are available.  If you 
hover the cursor over each button, a 
tooltip is available describing the 
buttons purpose. 

 

 
 

 
A brief explanation of each of the buttons and tools on the PLog Toolbar is included herein with 
more detailed explanation following. Refer to the figure below for the name of each button or 
tool. 
 

 The Login Button allows you to login to the database.  Once you have logged in the 
other tools are activated. 

 The Configuration Button allows you to perform the SDE Configuration as described 
above. 

 The Log Generation Button allows you to generate a Log report in gINT from the 
selected boreholes on the map. 

 The Fence Generation Button allows you to generate a Fence report in gINT from the 
selected boreholes on the map. 
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 The Graph Generation Button allows you to generate a Graph report in gINT from the 
selected boreholes on the map. 

 The Histogram Generation Button allows you to generate a Histogram report in gINT 
from the selected boreholes on the map. 

 The Graphic Table Generation Button allows you to generate a Graphic Table report in 
gINT from the selected boreholes on the map. 

 The Text Table Generation Button allows you to generate a Text Table report in gINT 
from the selected boreholes on the map. 

 The Graphic Text Doc Generation Button allows you to generate a Graphic Text Doc 
report in gINT from the selected boreholes on the map. 

 The Text Doc Generation Button allows you to generate a Text Doc report in gINT from 
the selected boreholes on the map. 

 
 The Fence Baseline Button allows you to generate a fence report using the selected 

boreholes and selected baseline in ArcMap. 

 The Draw Fence Baseline Tool allows you to draw a baseline in ArcMap and generate a 
fence report in gINT from the selected boreholes and drawn baseline. 

 The Buffer Selected Line Button allows you to buffer a selected line in ArcMap and 
select the boreholes within your specified distance of the selected line. 

 The Buffer Project Site Tool allows you to buffer a point on the map in ArcMap and 
select the boreholes within your specified distance of the specified point. 

 The Buffer Drawn Line Tool allows you to draw a line on the map and buffer it to select 
the boreholes within your specified distance of the drawn line. 

 The Query Button allows you to create and execute queries for data mining purposes. 
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 The Export Selection Button allows you to export the list of Project IDs and PointIDs to a 
text file such that they can be reimported and used at a later time. 

 The Import Selection Button allows you to import a list of Project IDs and PointIDs from a 
text file and select them on the map. 

 The Export gINT Project Button allows you to export the selected data to one or more 
gINT projects for further manipulation within gINT. 

General Report Generation  
The following section applies to all of the report styles i.e. logs, fences, graphs, histograms, 
graphic tables, etc.  Separate sections specifically for fences and graphs are included 
highlighting their specific reporting options.   
 

 Select the boreholes you want to 
generate a report for on the map using 
the ArcMap selection tool shown to the 
right.   

 Alternatively, the PLog buffering tools, 
PLog Import Selection Button, or the 
PLog Query tool can be used.  For a 
detailed explanation on the selection 
tools refer to Buffer Selected Line 
Button, Buffer Project Site Tool, Buffer 
Drawn Line Tool, PLog Import 
Selection Button or PLog Query Tool. 

 

 

 

 

 Selecting the any of the Report 
Generation Buttons (logs, fences, 
graphs, etc.) activates the dialog 
shown here. This dialog box provides 
the same reporting options you have in 
gINT. 

 From the dropdown list, choose the 
report you would like to generate. 

 To print the report, choose Print and 
click OK. 

 To preview the report, choose Preview 
and Click OK. 

 To export the report to a pdf or dxf file 
choose Export. Then click the Select 
button to specify the file to export it to 
and the resolution if it is a pdf file. 

 If you would like to view the document 
after export, check the View Document 
After Export checkbox. 
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 If you would like to change to a 
different report style use the Report 
Type menu at the top and choose the 
desired report style. 

 

Fence Generation 

 For fence report generation, the Fence 
Options panel is activated allowing the 
user to specify minimum and maximum 
values for vertical and distance axes, # 
divisions, initial baseline distance, 
viewing angles, etc. 

 For details on fence reporting options, 
please refer to the gINT help. Use the 
keyword “Fences (Output)” in the index 
for more information specific to fences. 
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Graph Generation 
 

 For graph report generation, the Graph 
Options panel is activated allowing the 
user to specify minimum and maximum 
values for independent and dependent 
axes, # divisions, and scales. 

 For details on graph reporting options, 
please refer to the gINT help. Use the 
keyword “Graphs (Output)” in the index 
for more information specific to graphs. 

 
 

Fence Baseline Button 
The Fence Baseline Button allows you to generate a fence report using the selected boreholes 
and selected baseline in ArcMap. 
 

 Select the boreholes you want to 
generate a report for on the map 
using the ArcMap selection tool 
shown to the right.   

 Alternatively, the PLog buffering 
tools, PLog Import Selection 
Button, or the PLog Query tool 
can be used.  For a detailed 
explanation on the selection tools 
refer to Buffer Selected Line 
Button, Buffer Project Site Tool, 
Buffer Drawn Line Tool, PLog 
Import Selection Button or PLog 
Query Tool. 

 Select the line used for the 
baseline from ArcMap using the 
ArcMap selection tool. 

 Click the Fence Baseline Button. 
When prompted whether or not to 
generate a fence report, select 
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Yes. 

 This activates the Fence Report 
Options dialog as described in 
the Fence Generation section. 

 

Draw Fence Baseline Tool 
The Draw Fence Baseline Tool allows you to draw a baseline in ArcMap and generate a fence 
report in gINT from the selected boreholes and drawn baseline. 

 
 

 Select the boreholes you want to 
generate a report for on the map 
using the ArcMap selection tool 
shown to the right.   

 Alternatively, the PLog buffering 
tools, PLog Import Selection 
Button, or the PLog Query tool 
can be used.  For a detailed 
explanation on the selection tools 
refer to Buffer Selected Line 
Button, Buffer Project Site Tool, 
Buffer Drawn Line Tool, PLog 
Import Selection Button or PLog 
Query Tool. 

 Click the Draw Fence Baseline 
Tool. 

 Click the left mouse button at 
starting point of the line on the 
map. 

 Continue left clicking each point 
until you reach the end of the 
baseline.  

 Double click the last point to end 
the polyline. 

 When prompted whether or not to 
generate a fence report, select 
Yes. 

 This activates the Fence Report 
Options dialog as described in 
the Fence Generation section. 
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Buffer Selected Line Button 
The Buffer Selected Line Button allows you to buffer a selected line in ArcMap and select the 
boreholes within your specified distance of the selected line.  

 

 Select a line for use as the buffer 
source using the ArcMap 
selection tool.  This may be a 
road, dam or levee centerline. 

 

 Click the Buffer Selected Line 
Button. 

 Specify the buffer distance and 
the units. 

 Click OK.  

 The image shown to the right is 
all boreholes within 1 mile of the 
selected road. 

 
 

Buffer Project Site Tool 
The Buffer Project Site Tool allows you to buffer a point on the map in ArcMap and select the 
boreholes within your specified distance of the specified point. 

 

 Click the Buffer Project Site Tool. 

 Click on the map where you want 
to select the boreholes. 
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 Specify the buffer distance and 
the units. 

 Click OK. 

 

 The image shown to the right is 
all boreholes within 1 mile of the 
specified point. 

 
 

Buffer Drawn Line Tool 
The Buffer Drawn Line Tool allows you to draw a line on the map and buffer it to select the 
boreholes within your specified distance of the drawn line. 

 
 Click the Buffer Drawn Line Tool. 

 Draw a polyline on the map to 
buffer.  

 Left click on each vertex of the 
polyline and then double click to 
end the polyline.  

 Specify the buffer distance and 
the units. 

 Click OK. 

 

 The image shown to the right is 
all boreholes within 0.5 mile of the 
drawn line. 

 

PLog Query Tool 
The query tool is used for non-spatially querying data in the database, whereas the buffering 
tools provide spatial querying capabilities. You can create queries based on values found in the 
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database such as (but not limited to) project name, city, or soil type.  Examples of a non-spatial 
query are:  

 Find all boreholes where the USCS is an SP or SM and N-Value < 8. 

 Find all boreholes where the project city = Atlanta and the state = Georgia. 

The latter query is the example shown in the following dialog boxes. 
 

 To build a query, start 
the PLog Query Tool. 

 
 From the Table 

dropdown list, choose 
the table you want to 
query values from first.  
In this case, choose the 
Project table. 

 Add the query criteria in 
the grid.  In the first row, 
select the Field = “City” 
and the Criteria is “=” 
and the Value is 
“Atlanta”. 

 Add a second row in the 
grid by specifying Field = 
“State” and the Criteria is 
“=” and the Value is 
“Georgia”. 
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 If you want to only find 
the values that fully 
match this criteria you 
must now specify the 
Group “And” to indicate 
the query must be City = 
Atlanta and State = 
Georgia.   

 If you choose the Group 
“Or” the query would be 
City = Atlanta or State = 
Georgia. This wouldn’t 
provide meaningful 
results if you are only 
looking for Atlanta 
because it would return 
all boreholes in the state 
of Georgia. 

 

 To execute the query, 
click the Find button.  
This will select the 
appropriate boreholes on 
the map within ArcMap. 

 

 To save the query, click 
the Save button.  This 
activates a dialog where 
you can specify the 
name of the query and 
type a description to help 
identify what the query 
will return.  

 To use a previously 
saved query, select a 
value from the Use 
Saved Query dropdown 
list.  Alternatively, you 
can click the Saved 
Queries tab and view the 
list in a grid with more 
details about the query. 

 If you want to clear the 
current query, choose 
the Clear button.   

 Warning: if you clear a 
saved query it will prompt 
you to save your 
changes once you close 
the form or switch tabs.  
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Saving the query will 
overwrite the changes.  
Use Save As if you don’t 
want to affect the original 
source query. 

 Clicking the Saved 
Queries tab allows you to 
view all saved queries 
and filter them by the 
user who created the 
query. 

 To select or edit a query, 
simply double click in the 
gray area to the left of 
the row you want to 
select.  This selects the 
query and returns you to 
the Query tab with the 
query populated in the 
grid. 

 Alternatively, you can 
highlight the row and 
select the Edit button on 
the form. 

 To delete a query, 
highlight the row to 
delete and click the 
Delete key on the 
keyboard or the Delete 
button on the form. 

 To only see the queries 
you have created, click 
on the Query Filter 
dropdown list and select 
your username. 

 Note: you may also 
select other usernames 
to filter queries. 

 

 

 

 

 

 

PLog Export Selection Button 
The Export Selection Button allows you to export the list of Project IDs and PointIDs to a text file 
such that they can be imported at a later time. 
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 Once a selection has been made 
using the various selection 
options, it can be saved for future 
use. 

 Click on the PLog Export 
Selection Button. 

 

 In the file selection dialog, select 
the folder where you want to store 
the file and name the file. 

 Click Save. 

 

PLog Import Selection Button 
The Import Selection Button allows you to import a list of Project IDs and PointIDs from a text 
file and select them on the map. 

 Click on the PLog Import 
Selection Button. 

 In the file selection dialog, select 
the file to import. 

 Click Open. 

 

 

 This selects the points on the 
map specified in the file. 
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PLog Export  
 
The Export Button allows the user to export the selected data to one or more gINT projects, 
Excel Files, Rockworks files, or Text files for further manipulation within some other application. 

 Select the boreholes you want to 
generate a report for on the map 
using the ArcMap selection tool 
shown to the right.   

 Alternatively, the PLog buffering 
tools, PLog Import Selection 
Button, or the PLog Query tool 
can be used.  For a detailed 
explanation on the selection tools 
refer to Buffer Selected Line 
Button, Buffer Project Site Tool, 
Buffer Drawn Line Tool, PLog 
Import Selection Button or PLog 
Query Tool. 

 Simply choose the folder where 
you would like the data to be 
exported.   

 Each project in the database will 
be created as a gINT, Excel, 
Rockworks or Text file 
(depending on your chosen 
export format) with its Project ID 
as its name. 
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Introduction 
Cone Penetration Testing (CPT) provides engineers with large amounts of data that can be 
used for analysis, typically up to 20 points per foot of exploration. Each raw data point typically 
consists of depth, tip resistance, sleeve friction, and pore pressure. Converting this raw data 
(usually a text file) to something useful that can be analyzed and reported is a tedious and 
cumbersome process.  It requires significant amounts of manual data manipulation (moving, 
copying and pasting) that is prone to human error.  Furthermore, to do anything useful with the 
data, the engineer must then calculate numerous parameters and correlations that can be used 
in follow-on design and analysis. 

Dataforensics RAPID CPT, a gINT Add-in, eliminates all manual data manipulation, providing a 
more complete and accurate interpretation of results, faster and easier than ever before. RAPID 
CPT allows you to import, process, analyze, report and deliver CPT results to your clients. 

CPT Data Import 
Dataforensics’ RAPID CPT makes importing data as easy as a few clicks of a mouse…without 
any transposition errors. Dataforensics has created the capability to import CPT data, pore 
pressure dissipation data, and shear wave velocity data from the raw text files and from AGS 
files. From a menu in gINT, simply choose which type of CPT data to import and select the 
file(s) to import. All data manipulation is automatically done for you. 

CPT Analysis & Reporting 
Once the CPT data is imported into gINT, you can start your analysis and reporting. 
Dataforensics RAPID CPT automatically calculates the following parameters upon importing the 
data into gINT: 

 Normalized Soil Behavior Type based on Friction Ratio– Qt vs Fr  
 Normalized Soil Behavior Type based on Pore Pressure – Qt vs Bq  
 Soil Behavior Type based on Friction Ratio– qt vs Friction Ratio  
 Soil Behavior Type based on Pore Pressure – qt vs Bq  
 Total Density (ρ)  
 Relative Density (Dr)  
 Void Ratio (e0)  
 Effective Friction Angle (φ’)  
 Constrained Modulus (M)  
 Coefficient of Lateral Earth Pressure (K0)  
 Undrained Shear Strength (Su)  
 Overconsolidation Ratio (OCR)  
 Sensitivity  
 Fines Content  
 Equivalent (N)60 

 
Any change you make to values that affect the calculations such as total density or water depth, 
updates all calculations immediately. Thus all changes are reflected immediately on all reports 
you generate. You no longer have to recalculate values in Excel or whatever program you are 
using, and then import the data into gINT again to include it on borehole logs, CPT reports, etc. 
Dataforensics’ RAPID CPT allows you to perform the entire analysis and reporting process 
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within one software package. If you change one value in gINT, all values are updated, and all 
graphs immediately reflect the changes. 
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Tutorial 1 – Importing Data 
RAPID CPT facilitates analyzing CPT data by removing three of the most cumbersome manual 
processes involved with analyzing CPT data using traditional tools such as Excel: manipulation 
of the data, calculating various correlations and parameters, reporting and comparing, data and 
correlations. 

In this tutorial we will illustrate how to import each of the three types of data that can be 
imported using RAPID CPT: CPT data, Pore Pressure Dissipation Data, and Shear Wave 
Velocity Data. 

Create a new gINT Project 
 Start gINT. 

 Once you have installed RAPID CPT, verify the RAPID CPT library (CPT Library.glb) or 
your custom library created by Dataforensics is open in gINT.  

 To change the library, go to the File menu in gINT and select ‘Change Library’ and select 
the appropriate .glb file. 

 Create a new gINT project by cloning the RAPID CPT data template (cpt.gdt) or using 
your custom data template created by Dataforensics. 

 To create a new project go to the ‘File’ menu in gINT and select                     ‘New 
Project’->’Clone Data Template’. 

 Select the CPT.gdt as the source data template. 

 
 Specify a new file name for the new project you are creating.  In this example shown 

below it is named ‘Tutorial 1.gpj’. 
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Now you are ready to import data into the Tutorial 1 project.  You can import as many CPT 
soundings as you would like into this project.  
 
Import qt, fs, u2 data 
You will import qt, fs, and u2 data from a text file. Currently RAPID CPT supports the following 
formats: 

 Vertek (.ecp) file format.  The stress units for Vertek files can be in tsf, bars, psi, kPa 
or MPa for qt, fs, u2.  

 Vertek (.dat) file format.  The units for Vertek .dat files are volts.  

 Hogentogler digital file format.  The stress units for the Hogentogler digital files can 
be in tsf, bars, psi, kPa or MPa for qc, fs, u2. 

 Hogentogler analog file format.  The stress units for the Hogentogler analog files can 
be in tsf, bars, psi, kPa or MPa for qc, fs, u2. 

 Geotech AB and Envi AB (.cpd) file format.  Geotech AB and Envi AB files are only in 
metric. Therefore, the stress units for these files can only be in MPa for qc, qt, fs, u2. 

 ConeTec files (.cor) format.  The stress units for the ConeTec digital files can be in 
tsf, bars, psi, kPa, MPa, feet of water or meters of water, for qc, fs, u2. 

 Gregg Drilling files (.cor) format.  The stress units for the Gregg Drilling digital files 
can be in tsf, bars, psi, kPa, MPa, feet of water or meters of water, for qc, fs, u2. 

 A P van den Berg files Gorilla format.  The stress units for these files can be MPa for 
qc, fs, u2. 

 AGS file format. The stress units for AGS files are MPa.  
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 Units for data in the input file must be in all English or metric units. However, 
measurements for each item do not need to be the same. For example, an import file 
can have qc and fs in tsf and u2 in psi.  

Other custom importers for other CPT manufacturers can be created upon request. 

 If you have merged the RAPID CPT Project table fields and the CPT and CPT Data 
tables in to your company’s gINT data template or had Dataforensics create a custom 
data template for you, you must specify a correspondence file prior to importing the CPT 
data file so data in the Project and Point tables are imported to the correct fields in your 
data template. From the Add-Ins menu in gINT, select the Import Data->Specify CPT 
Import Correspondence File. Note: You can develop your own correspondence file or 
Dataforensics can create a correspondence file for you. 

 If you are importing CPT data from an AGS file you must specify a correspondence file 
prior to importing the CPT data file even if you are using the standard RAPID CPT data 
template.  Use the rapid cpt ags import.gci file. 

 From the Add-Ins menu in gINT, select the data type you wish to import. Select Import 
Data->Import Data. Then select the specific CPT data file you wish to import (Vertek, 
Hogentogler, Geotech AB or AGS).  

 
 

 The dialog shown below will appear. It prompts you to specify the CPT Stress units, CPT 
Density units, the default moving average for Soil Behavior Type (SBT) and the Cone 
Net Area ratio. Once the appropriate values are entered in the dialog box select OK. 

 Stress and density units in this dialog box are the units you wish to report the 
data in, and do not need to be the same units as the file being imported. You 
may specify the output units to be tsf, bars, psi, kPa or MPa for stress units, 
and pcf, g/cc, kN/m3 or Mg/m3 for density units. Stress and density units must 
be within the same system (metric or English). 

 Default moving average is used in a moving average calculation for the soil 
behavior types. A moving average of 1 means each Soil Behavior Type will be 
plotted. A moving average of 5 means that the Soil Behavior type will be 
averaged over 5 depth intervals (from 2 depths above to 2 depths below the 
current depth).  This value can always be changed later without having to import 
the data again. 

 Cone Net Area ratio must be specified for the cone in order to calculate qt and 
any subsequent correlations that use it. 
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 Select one or more CPT data files to import into gINT and click Open. If you have 20 
CPT soundings you can select all 20 files at once.  

 
 

When you import files in English units and are converting them to metric, or vice versa, a pop up 
will appear asking if you wish to convert the coordinate values (Northing, Easting and Elevation) 
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as well. Select Yes to convert the coordinates along with the CPT data or No to keep the 
coordinates in the original data form. 

 
 

Import Pore Pressure Dissipation Data 
Next you will import pore pressure dissipation data from a text file. Currently RAPID CPT only 
supports the Vertek pore pressure dissipation file format. The Vertek pore pressure data will be 
in a text (.txt) file. Other custom importers for other CPT manufacturers such as Hogentogler, 
Geotek AB, or A.P. Vandenburg can be created upon request. 

 Importing pore pressure dissipation data follows the same process as importing CPT 
data. From the Add-Ins menu, select Import Data->Import Pore Pressure Dissipation 
Data. 

 Select one or more Pore Pressure Dissipation data files to import into gINT and click 
Open. If you have 20 dissipation tests you can select all 20 files at once. 

Import Shear Wave Velocity Data 
Last, you an import shear wave velocity data from Excel spreadsheets.  The format that RAPID 
CPT can import is provided in the sample files.  Note: If you wish to import shear wave velocity 
information, Dataforensics will send you a formatted Excel sheet. 

 Importing shear wave velocity data follows the same process as importing CPT data. 
From the Add-Ins menu, select Import Data->Import Shear Wave Velocity Data. 

 Select one or more Shear Wave Velocity data files to import into gINT and click Open. If 
you have 20 soundings with shear wave velocity data you can select all 20 files at once. 

Alternatively, this data can be typed into gINT directly. 

You have now imported all types of data into RAPID CPT and are ready to begin the process of 
analyzing the data as described in Tutorial 2. 
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Tutorial 2 – Modifying Default Values with RAPID CPT 
The following three figures illustrate data imported by RAPID CPT and how the user can 
configure RAPID CPT in the project, point and/or CPT table to vary the analysis parameters.  
 
Project Table 
In the Project table shown below, the user may specify values for Water Unit Weight, Drained 
Threshold Zone, Drained Threshold Soil Behavior Type, Phi in K0 Calc, OCR in K0 Calc, Dr in M 
Calc, Nu . NkT, Nk,Nc, and Use Estimated Total Density Values. Each of these parameters and 
their effect on the analysis is described.  If you change any of these parameters, you must 
go to the CPT table and then select from the gINT Rules menu->Recalculate Current 
Table to ensure all calculations are updated. 
 

  
Project Table 

Water Unit Weight – If you want to override the default unit weight of water (62.42796 pcf), 
input a value in this field. The value in this field will affect the hydrostatic pore pressure 
calculation and consequently the effective stress calculation. 

Drained Threshold Zone - This field is used to determine the threshold for specifying whether 
the soil exhibits drained or undrained behavior based on normalized SBT zones. This affects 
OCR, Su, Phi', Dr, M, St, and Fines Content calculations. Specify the minimum zone number for 
which drained behavior will be evaluated - i.e. if 4 is selected, zones 4-9 have drained behavior. 
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If the SBT is 4 – 9, the correlations for Su, OCR, M(1) and M(3) and St are not calculated. Thus, 
only values for Phi’, Dr, and M(2) correlations which apply to silts and sands are calculated.  

Max Drained Threshold Zone - This field is used to determine the maximum threshold for 
specifying whether the soil exhibits drained or undrained behavior based on normalized SBT 
zones. This affects OCR, Su Phi', Dr, M, St, and FC calculations.  Specify the maximum zone 
number that drained behavior will be evaluated i.e. if 7 is selected, zones 4-7 have drained 
behavior. This drained threshold is only used by the normalized soil behavior types. 

Drained Threshold Soil Behavior Type – This allows you to specify which Normalized Soil 
Behavior Type to use in the Drained Threshold Evaluation. The user can specify the Normalized 
SBT Bq plot or the Normalized SBT Fr plot (zones 1-9). 

Phi in K0 Calc and OCR in K0 Calc – These fields allow you to specify which value of Phi’ and 
which value of OCR to use in the K0 (1) calculation. 
K0 (1) = 1 - sin(Phi’) * (OCR ^ sin(Phi’)) 
 
Dr in M Calc – This field allows you to specify which relative density value is used in the 
Modulus Calculation. M (2) = qc * 10 ^ (1.09 - 0.0075 * Dr) 

Nu – This field allows you to specify which value of Nu to use in the Su (1) calculation.   Su (1) = 
(u2 - u0) /Nu 

NkT.- This field allows you to specify which value of NkT to use in the Su (2) calculation. Su (2) = 
(qt – σvo)/NkT 

Nk.- This field allows you to specify which value of Nk to use in the Su (4) calculation. Su (4) = (qc 
– σvo)/Nk 

Nc.- This field allows you to specify which value of Nc to use in the Su (5) calculation. Su (5) = 
(qt)/Nc 

Use Estimated Total Density Values - Use this field to specify that the total stress calculations 
should be based on the estimated total density values. If it is false (not selected), RAPID CPT 
will use the Assumed Total Density in the CPT table.  If it is selected as true, it will use the 
estimated total density values unless you have entered a Total Density for specific depth 
intervals in the CPT data table.  

 When you select Use Estimated Total Density Values as true, RAPID CPT will use the 
values in the gINT library table “SBT Total Density Values”. The values are those 
detailed in Cone Penetration Testing in Geotechnical Practice by Lunne, Robertson, and 
Powell (1997).  

 Any values you have entered for any SBT zone and the associated Total Density in the 
CPT Total Density table will override the same SBT zone values in the SBT Total 
Density Values for analysis.  

K in OCR(1) Calc – Use this field to specify the k constant in the OCR 1 calculation. If nothing 
is specified 0.33 is used as a default value. 

Use qc in Correlations – Use this field to have RAPID CPT perform all applicable correlations 
using qc instead of qt. 
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Location Type – Use this field to report either Latitude/Longitude, Northing/Easting or 
Station/Offset in the header of the CPT reports. 

Logo – Use this field to show different logos on the CPT reports.  If nothing is specified, the first 
logo in the Library Table named Logos will be printed. To add other logos to your files, refer to 
Tutorial 7. 

Point Table 
There are no fields in the point table which affect the calculations.  However, the values in the 
fields shown below are imported from the CPT data files. 

 
 

CPT and CPT Data Tables 
The CPT Table is the parent table which stores information specific to each CPT Sounding, and 
the CPT Data table stores the fs, qc, qt and u2 data. The fields Assumed Water Depth, Assumed 
Total Density, the SBT moving average fields and the Net Area Ratio field (for the cone) in the 
CPT table affect calculations in the CPT Data table.  If any values in this table are modified, all 
values are recalculated automatically. 
 
Similarly, if any values in the CPT Data table are modified, all fields shown in gray are 
recalculated automatically as well. 
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Tutorial 3 – Setting Total Density Values  
The RAPID CPT tool allows you to specify total density values for materials in four different 
manners.  The order of precedence for which density is used in calculations is as follows.  
 

1. Total Density Override with depth 

2. Project Specific Total Density values based on the Soil Behavior Type 

 Values in the CPT Total Density Table  

 Values in the Soil Behavior Type Zone in the Library Table SBT TOTAL 
DENSITY VALUES (if no values are in the CPT Total Density Table.) 

3. Assumed Total Density for the entire sounding in the CPT table 

4. If no assumed total density is entered for a sounding, 120 lb/ft3 (18.9 kN/m3) is 
assumed. 

The user’s manual herein details how each level works from default up through Total Density 
Override with Depth. 

Default Total Density Values 
 
If there is no unit weight in the CPT raw data file, then after import RAPID CPT will perform an 
initial analysis using an assumed unit weight of 120 lb/ ft3 (18.9 kN/m3).  
 
Setting Total Density Values for the entire sounding 
 
If selected CPT data files have an estimated total density, the value will be imported in to the 
Assumed Total Density field in the CPT table, as shown below. An assumed total density may 
also be manually entered in the Assumed Total Density field if a value was not present in the 
CPT data file or if another value for this sounding is preferred for analysis. 
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Having RAPID CPT determine the Total Density Automatically  
Select the “Use Estimated Total Density Values” field in the project table to have RAPID CPT 
determine the total density values for each depth interval based on the soil behavior type. Any 
depth specific density values in the Override Total Density field in the CPT data table will 
override this setting though. 
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By Default, RAPID CPT will use the Estimated Density values in the library table SBT Total 
Density Values, which is shown below. The SBT Total Density Values table has the estimated 
total density values as detailed by Lunne et al (1997).  
 
When setting the Estimated Density based on SBT zone, the non-normalized SBT from the 
Friction Ratio is used for the evaluation.  
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If you want to override any or all of the estimated total densities listed in the SBT Total Density 
Values table in RAPID CPT, you may enter a different estimated total density for each SBT 
zone in the Input table CPT Total Density. Any Soil Behavior Type Zone with a Total Density 
value in the CPT Total Density table, as pictured below, will be used as the estimated density 
for materials of the SBT zone for evaluation in RAPID CPT, unless you have specified Override 
Total Density values at depth in the CPT data table.  
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Setting Total Density Values for Specific Depth Intervals 
You can specify the total density for materials at specific depth intervals for a sounding. This 
density value overrides all other density values you may have specified as described above in 
evaluating CPT data.  
 
If the density of the soil profile varies it is straightforward to include the variation in the analyses.  
 

 To set the Total Density Override values in the CPT Data table you can input the values 
directly in the CPT Data table or you can select from the Add-Ins menu Set Override 
Values->Set Total Density Values. 

 The following dialog appears. You now enter a depth, bottom depth and the associated 
Total Density Override value.  Input the values and click Apply.  You may repeat this 
process as many times as necessary. 

 Click close to return to the table where you will see the values have been set for the 
Total Density Override field in the CPT data table. 
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Tutorial 4 – Investigating the Moving Average on the 
Soil Behavior Type 
The RAPID CPT tool allows you to investigate the differences in moving average intervals for 
each of the four soil behavior types.  To view the smoothing effect of moving average variation, 
select a CPT sounding from the CPT table.  Then go to the Add-Ins menu and select Calculate 
SBT Moving Average and then select one of the four options shown in the Figure below. 
 

  
Soil Behavior Type Moving Average 

 To investigate the smoothing of the Soil Behavior Type based on the Normalized Friction 
Ratio, select the first option, Calculate Normalized SBT Fr Moving Average, from the 
menu.  The following dialog appears. 

 
Moving Average Intervals 

 Input the desired moving average intervals.  The moving interval is calculated such that 
half of the entered interval is taken above and half is taken below the point being 
averaged. For example, an interval of 5 will average from 2 points above a specific depth 
to 2 points below the specific depth.  Conversely, a moving average of 1 is no averaging. 

 To preview the report, click ‘Preview’.  This calculates the values and then previews the 
appropriate report automatically (the reports that are used to preview are CPT Report – 
SBT FR Normalized – 3 Graphs, CPT Report – SBT FR– 3 Graphs,  CPT Report – SBT 
Bq Normalized – 3 Graphs, CPT Report – SBT Bq – 3 Graphs). If you only want to 
calculate the values but will report them later, click the ‘Calculate’ button. 
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Tutorial 5 – Setting N values used in Undrained Shear 
Strength Calculations 
The RAPID CPT tool allows you to specify N values used in undrained shear strength 
calculations in three different manners.  The order of precedence for which N value is used in 
calculations is as follows.  
 

1. CPT Override N value Constants at the point level 

2. CPT Override N value Constants at the project level 

3. CPT N values in the Project Table 

The user’s manual herein details how setting works from default up through CPT Override N 
value Constants at the point level. 

CPT N values in the Project Table 
N values in the point table are: Nu, NkT, Nk and Nc. When you import a CPT data file, a default 
value for each N value is set. If you change the N values and then import new CPT data, the N 
values are reset to the default value. The default N values set when CPT data is imported are 
as follows:  

 Nu = 7 

 NkT = 15 

 Nk = 15 

 Nc = 20 

For each N value there is a range of values you can select from a drop down list. The value 
range is based on the current state of practice in CPT data evaluation.  
 
CPT Default N value Constants by Soil Behavior Type Zones 
RAPID CPT allows you to override the N value constants used to evaluate undrained shear 
strength in the project table with N values based on the Soil Behavior Type Zone.  
 
When setting the N value constants based on SBT zone, the non-normalized SBT based on the 
friction ratio is used for the evaluation.  
 
To override the project level N value constants based on SBT zone for the entire project go to 
the CPT Default N Value Constants table in Input. The table is shown below. Select the desired 
zones you wish to enter an N value override, and enter the desired N value constant. The N 
value constants used in this table will be used throughout the entire project unless overridden 
with the N value constants by point described below.  
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CPT Override N value Constants by Soil Behavior Type Zones 
RAPID CPT allows you to override all other N values on a sounding by sounding basis for each 
SBT zone. This N value constant override will override all other N value constants you have 
entered within RAPID CPT as described above.  
 
As with the Default N value Constants at the project level, the normalized SBT is used to 
determine the N values for a soil. You can decide if you wish to use the SBT based on Bq or Fr 
by selecting the desired condition in the Drained Threshold Behavior Type field in the project 
table. 
 
To override the project level N values go to the CPT Override N Value Constants table in Input. 
The table is shown below. First select the sounding you would like to override the N value 
constants for from the dropdown list at the top of the screen.  Then select the desired zones you 
wish to enter an N value override, and enter the desired N value.   
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Tutorial 6 – RAPID CPT Reporting Capabilities 

Log Reports (Logs tab in gINT) 
There are two log reports that have been created in RAPID CPT that allow for any combination 
of parameters to be plotted, the CPT Report – Standard and CPT Report Dynamic. 

CPT Report – Standard 
The CPT Report – Standard is a quasi-static report. It allows the user to plot qt, fs, Pore 
Pressure, Friction Ratio, Normalized Soil Behavior Type based on Friction Ratio, and the user 
can specify whether to include an equivalent N60 plot or a Shear Wave Velocity plot. 
 

 To generate this report, go to the Output module in gINT.  From the pull down list at the 
top, select the CPT Report – Standard as shown below.  Select the desired soundings to 
preview in the PointID field and click the Preview button . If you want to print the 
report, click the printer button. 

 A dialog will appear prompting you to specify if you want to show Shear Wave Velocity 
plot on the report. Any value input in the associated field, will cause the Shear Wave 
Velocity to be plotted instead of an equivalent N60 plot. 
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CPT Report – Dynamic 
The CPT Report – Dynamic is a completely dynamic report. It allows the user to specify which 
parameters to include on the report and in which column position the parameter will be plotted.  
You can specify up to 6 different plots on the dynamic report.  
 

 To generate this report, go to the Output module in gINT.  From the pulldown list at the 
top, select the CPT Report – Dynamic.  Select the desired soundings to preview in the 
PointID field and click the Preview button  .  If you want to print the report, click the 
printer button instead. 

 The dialog shown below will appear.  Input the numbers 1 through 6 in the fields next to 
the parameter to plot.  In the example shown below, the parameters will be plotted in the 
following order: qt, fs, Pore Pressure, Normalized SBT FR, Normalized SBT Bq, and 
Undrained Shear Strength. 

 

Report Configuration  
There are numerous configuration capabilities that apply to all the log forms in RAPID CPT. To 
modify any of these options, go to the CPT Report Configuration table in Input as shown below.   
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 By default, the check boxes (Boolean fields) are unchecked (set as false). All items with 
a check box will be shown as long as the check box is unchecked. If you wish to hide a 
secondary axis or a specific item, you must enter a check the appropriate box. The 
following are examples hiding a secondary axis and a specific item.  

 When you display a graph with qt on it, by default there will be a primary axis and 
a secondary axis and two plots. To hide the secondary Plot as well as the 
secondary axis on the qt plot, check the ‘Hide Secondary qt Plot’.  
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 The primary axis maximum is determined dynamically based on the maximum value for 
all soundings in the database unless you input a value in the Override :  for the following 
items: qc, qt, fs, u2, FR, Vs, K0, Dr, OCR, Phi, Sensitivity, Fines Content, Void Ratio and 
Su. 

 The maximum value on the secondary axis is always set as 100 tsf, 200 ksf, 10000 kPa, 
10 MPa or 10 Bars for qt and as 8 tsf, 0.8 psi, 16 ksf, 800 kPa, 0.8 Mpa and 0.8 bars for 
u2 and u0. 

 Several options have been added in RAPID CPT 3.0 (shown above) which allow the 
user to specify the Default SBT used on the reports, how the SBT is plotted as either a 
bar graph or a graphic column, and either plotting Su and Equivalent N Value on 
arithmetic or log scales. 

Fence Reports (Fences tab in gINT) 
There are several fence diagrams included in RAPID CPT, CPT - Elevation 11x17, CPT - 
Elevation 11x17 with Strata, CPT – Elevation 11x17 dynamic, and 4 overlay fence reports which 
can be used to do comparisons of a various parameters across multiple soundings.     

 To print or preview a fence diagram, follow the same procedure for generating a log 
report from above, except you first select the Fences tab in gINT. 

 
Graph Reports 
There are seven graph reports included in RAPID CPT: The CPT Parameter Plot – qt, CPT – 
Parameter Plot SU (1), CPT – Parameter Plot SU (2), CPT – Parameter Plot SU (3), CPT – 
Parameter Plot SU (4), CPT – Parameter Plot SU (5), and CPT - Pore Pressure Dissipation.  
The CPT Parameter Plot – qt graph allows you to select up to 20 different soundings to overlay 
the qt value on a single graph. The CPT – Parameter Plot for SU of any number plots all the 
values for the specified SU parameter in the project.  The CPT Pore Pressure Dissipation allows 
you to view Pore Pressure Dissipation test results. 

 To print or preview a graph report, follow the same procedure for generating a log report 
from above, except you first select the Graphs tab in gINT. 

 

Tutorial 7 – Adding New Logos 

To add new logos to your gINT Library, follow these steps: 

 Select the Symbol Design tab in gINT. 

 Depending on whether the file is an image file or a CAD File, proceed through each 
section accordingly. 

Bitmap Symbols (.bmp, jpeg, tiff, etc). 

 Select the Bitmap Symbols tab to import a bitmap, jpeg, etc or the Discrete 
Graphics tab to import .dxf files to use for the logo. 
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 Go to the File menu and select New and name your logo. 

 Click the Load Raster file and choose the image to import. 

 Proceed to the next step following discrete graphics. 

Discrete Graphics (.dxf) 

 Select the Discrete Graphics tab to import .dxf files to use for the logo. 

 Go to the File menu and select New and name your logo. 

 Go to the File menu and choose Import/Export->DXF Import. 

 Choose your file and click Open. 

 

Now that you have imported the image into gINT, add this to the list to be used for 
specifying the logo.  Note that the first logo in the table here is the one that is used by 
default unless otherwise specified. 

 Click the Data Design Tab. 

 Click the Library Data Tab. 

 From the dropdown list at the top (in yellow), choose Logos. 

 Add a new row in this table naming it whatever you want and then choosing either 
the bitmap symbol, discrete graphic or both. 
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CPT Correlations 
References are in parenthesis next to the appropriate equation. 

 
General 
pa=atmospheric pressure (for unit normalization) 
qt=corrected cone tip resistance (tsf) 
fs=friction sleeve resistance (tsf) 
Rf = 100%·(fs/qt) 
u2=pore pressure behind cone tip (tsf) 
u0=hydrostatic pressure 
 
Bq = (u2-u0)/( qt-σvo) 
Qt=(qt-σvo)/ σ΄vo 
Fr=100% · fs/( qt-σvo) 
Ic = ((3.47-logQt)2+(logFr+1.22)2)0.5      2 
ISBT = ((3.47-log(qc/pa))2+(logFr+1.22)2)0.5     23 

 

  
Ko 
K0 (1) Ko = (1-sinφ)OCRsinφ 

K0 (2)   Ko = 0.1(Qt) 1 

 
Stress History 
OCR = σp΄/σ’vo  
(OCR 1)  σp΄ = 0.33(qt – σvo) 8 
(OCR 2)  σp΄ = 0.53(u2 – uo) 9 
(OCR 3)  σp΄ = 0.60(qt – u2)  9 
 
N-Value 
N60 = (qt/pa)/[8.5(1-Ic/4.6)] 6 
 
Undrained Shear Strength 
Su (1)  Su = (u2 – uo)/Nu  where 7 ≤ Nu ≤ 9 10 
Su (2)   Su = (qt – σvo)/NkT  where 15 ≤ NkT ≤ 20  11 
Su (3)  Su = 0.091 * ((σ’vo

0.2) * (qt – σvo )0.8  21 

Su (4)  Su = (qc – σvo)/Nk    where 15 ≤ Nk ≤ 20  11 
Su (5)  Su = qt/Nc     where XXX ≤ Nc ≤ YYY 
Su (6)  Su = qc/Nc     where XXX ≤ Nc ≤ YYY 

 
 
 
Drained Friction Angle 
φ΄ (1)   φ΄ = 17.6 + 11.0Log[qt/(σvo΄)0.5] 1 
φ΄ (2)   φ΄ = arctan[0.1 + 0.38Log(qt/σvo΄)] 13 
φ΄ (3)   φ΄ = 30.8Log[(fs/σvo΄)+1.26]   (for clays or sands) 14 
φ΄ (4)   φ΄ = 29.5 Bq

0.121 (0.256 + 0.33 Bq + Log(Qt))    24 
 
Unit Weight 
ρ = γ/γw 
ρ = 0.8Log(Vs) Vs in m/sec 17 
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Relative Density and Void Ratio 
DR (1)  DR = 100(qc1/305)1/2 where, qc1 = qc/( σvo΄)1/2 1 
DR (2)  DR = -1.292 + 0.268ln(qc · (σvo΄-0.5)) 18 
DR (3)  DR = (1/2.41)·ln(qc1/15.7) 3 
DR (4)   DR = 1/2.91 * ln((qc/(61* σ'vo 

0.71))*100          20 

 
 
eo = 1.099 – 0.204log(qc1) 1 
 
ED = 5 qt ID = 2.0 – 0.14(Rf) KD = ED/(34.7·ID· σvo΄)  
 
Compressibility 
M (1) = Rm ED  where Rm= function(ID, KD) see the following table  22 
 

ID <= 0.6 RM = 0.14 + 2.36 log KD 

ID >= 3 RM = 0.5 + 2 log KD 

0.6 < ID < 3 RM = RM,D + (2.5 - RM,D)log KD 

RM,D = 0.14 + 0.15(ID – 0.6) 

KD > 10 RM = 0.32 + 2.18 log KD  

RM < 
0.85 

RM = 0.85 

 
M (2)   M = qc·10(1.09-0.0075DR) sands     1 
M (3)   M = 8.25 (qt - σvo) clays     1 
 
Sensitivity 
St (1)   St = 7.5/Rf 2 
St (2)   St = (qt - σvo)/(15·fs) 2 
 
Fines Content 
FC = [(3.58-log(qt))2+(1.43+log(Rf))2]1.8 4 
FC = [5.31(Icfs)2.31]+9.61, where Icfs = [(1.95-LogQt)2+(logFr+1.78)2]0.5 4 
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Normalized Soil Behavior Types - Robertson & Campanella (1990) 
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Non-Normalized Soil Behavior Types – Robertson & Campanella 
(1986) 
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